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Section 1 Safety information

Please read this entire manual before this equipment is unpacked, set up, or operated.
Pay attention to all danger, warning, and caution statements. Failure to do so could result
in serious injury to the operator or damage to the equipment.

D A N G E R
 

Indicates a potentially or imminently hazardous situation which, if not avoided, will result in death
or serious injury.

W A R N I N G
 

Indicates a potentially or imminently hazardous situation which, if not avoided, could result in
death or serious injury.

C A U T I O N
 

Indicates a potentially hazardous situation that may result in minor or moderate injury.

N O T I C E
 

Indicates a situation which, if not avoided, may cause damage to equipment. Information that
requires special emphasis.

1.1 Hazard information

W A R N I N G
 

This product can expose the user to chemicals with silica, crystalline (airborne particles of
respirable size), which is known to the State of California to cause cancer and birth defects or
other reproductive harm. For more information, go to www.P65Warnings.ca.gov.

W A R N I N G
 

Sensors that use ultraviolet light sources (< 400 nm): Do not look directly at a UV light
source when it is on. It can cause damage to the eyes. Keep products that have UV
light sources away from children, pets, and other living organisms. Wear polycarbonate
UV-resistant safety glasses to protect the eyes when a UV light is on.

N O T I C E
 

The manufacturer is not responsible for any damages due to misapplication of misuse of this
product including, without limitation, direct, incidental and consequential damages, and disclaims
such damages to the full extent permitted under applicable law. The user is solely responsible to
identify critical application risks and install appropriate mechanisms to protect process during a
possible equipment malfunction.

1.2 Equipment labels
Read all labels and tags attached to the equipment. Personal injury or damage to the
equipment could occur if not observed. A symbol on the equipment is referenced in the
manual with a precautionary statement.

Do not look directly at a UV light source when it is on. It can cause damage to the eyes. Keep products
that have UV light sources away from children, pets, and other living organisms. Wear polycarbonate
UV-resistant safety glasses to protect the eyes when a UV light is on.
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EFUP: Hazardous material exists over the threshold of GB/T 26572.2011. The number in the center of
the symbol is the Environmentally Friendly Use Period as specified by SJ/T 11364-2014, China's
marking for the Restriction of the Use of Hazardous Substances in Electrical and Electronic Products.
This product should be recycled after its environmentally friendly use period.

Electrical equipment marked with this symbol may not be disposed of in European domestic or public disposal
systems. Return old or end-of-life equipment to the manufacturer at no charge to the user.

Safety information
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Section 2 SUNA quick start guide

This quick start guide gives the steps necessary to set up and make sure that the SUNA
sensor operates and collects data before it is deployed.
Delivered items—

• the SUNA sensor, either standard or "deep" rated, with optional wiper, if ordered (std.
depth only)

• dummy plug and lock collar

1. Install the manufacturer-supplied software on a PC. (Install and start software
on page 9)

2. Verify that the sensor operates and collects data: (Verify sensor operation
on page 9)

a. Connect the sensor to the PC and start the software.
b. Supply external power to the sensor.
c. Push Connect to start communication with the sensor.
d. Push Start to collect data.
e. Remove and replace the protective cover on the optical face several times to

change the value of the collected data.
f. Push Stop to stop data collection.

3. Verify that the sensor transmits data: (Verify sensor transmits data on page 12)

• Push Transmit Data in the dashboard and select "All Data" to transmit data
collected by the sensor to the PC.

• Open the file on the PC to look at the data.
4. Use the "Deployment Wizard" in the software to set up the sensor for a specific

deployment. (Deployment wizard on page 15)
5. If necessary, attach the sensor to the frame on which it will be deployed.
6. Make sure to do maintenance on the sensor at regular intervals. (Sensor

maintenance on page 23)
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Section 3 Specifications

3.1 Mechanical

SUNA with optional wiper Standard SUNA

Rated depth 100 m 500 m

Weight (in air) 4.8 kg 3.9 kg

Pathlength 10 mm 5 mm 10 mm 5 mm

Length 58.8 cm 58.3 cm 55.1 cm 54.6 cm

Displacement 2077 cm³ 2073 cm³ 1692 cm³ 1688 cm³

Diameter 6.3 cm

Material Titanium (acetyl wiper)

Temperature range, operation 0–35 °C

Temperature range, dry storage -20–50 °C

3.1.1 Bulkhead connector

Contact Standard Optional (USB/SDI-12) MCBH-8-MP

1 Voltage in 8–18 VDC (15 VDC for sensors with wiper)

2 Ground

3 — USB 5 V power

4 — SDI-12

5 RS232 TX RS232 TX/USB D+

6 RS232 RX RS232 RX/USB D-

7 — Analog V out

8 — Analog current out

3.2 Electrical

Input 8–18 VDC

Input, sensor with wiper 8–15 VDC

Current draw, maximum 1.5 A

Current draw, operation ~625 mA at 12 V (nominal)

Current draw, supervised low power (periodic mode) <30 µA

Current draw, processor low power (controlled mode) <3 mA

Current draw, standby (SDI-12 mode) ~20 mA at 12 V

Baud rate 57600 (9600, 19200, 38400, 115200 available)

Communication interface RS232 (USB and SDI-12 optional)

Data storage 2 GB (optional)
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3.3 Optical

Spectral range 190–370 nm

Light source UV deuterium lamp

Light source lifetime 900 hrs

3.4 Analytical
This sensor is designed to measure the concentration of nitrate ions in water.
Measurements are in units of micro molar (µM). This is converted into mg/L. Note that
1 µM nitrogen = 0.014007 mg/L nitrogen.

3.4.1 Nitrate measurement accuracy
Table 1  5 mm pathlength

Concentration range Class-based fresh water Fresh water Seawater

Best 0.063 mgN/L (4.5 µM) 0.056 mgN/L (4 µM) 0.056 mgN/L (4 µM)

up to 1000 µM (14 mgN/L) 20% 10% 10%

up to 2000 µM (28 mgN/L) 25% 15% 15%

up to 3000 µM (42 mgN/L) 25% 15% 15%

up to 4000 µM (56 mgN/L) 25% N/A N/A

Table 2  10 mm pathlength

Concentration range Class-based fresh water Fresh water Seawater

Best 0.035 mgN/L (2.5 µM) 0.028 mgN/L (2 µM) 0.028 mgN/L (2 µM)

up to 1000 µM (14 mgN/L) 20% 10% 10%

up to 2000 µM (28 mgN/L) 25% 15% 15%

up to 3000 µM (42 mgN/L) 30% 20% 20%

up to 4000 µM (56 mgN/L) N/A N/A N/A

The specified accuracy is best accuracy or a percentage, whichever is more.

• A sensor-specific calibration uses extinction coefficients from the sensor itself.
• A class-based calibration uses extinction coefficients that are the average of many

sensors.

3.4.2 Nitrate measurement precision

Processing configuration Seawater or fresh water with T-S
correction

Seawater (0–40 psu)

Short-term precision (3 sigma) and limit of detection 0.3 µM (0.004 mgN/L) 2.4 µM (0.034 mgN/L)

Change ("drift") per hour of lamp time < 0.3 µM (< 0.004 mgN/L) < 1.0 µM (< 0.014 mgN/L)

Limit of quantification 1.0 µM (0.014 mgN/L) 8.0 µM (0.112 mgN/L)

Specifications
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Section 4 Set up sensor and verify operation

4.1 Install and start software
Install the manufacturer-supplied software and make sure that the sensor is ready to test
for functionality before configuration and deployment. If the sensor is so equipped, install
the batteries if necessary. The manufacturer-supplied UCI software communicates with a
number of sensors. The sensors that are supported are listed in the Sensor menu of the
software.

1. Get the software from the manufacturer's website or the manufacturer-supplied USB
drive or CD.

2. Install the appropriate software.

a. For Windows®: Double-click on the file with ".exe" appended to the name.
b. For Mac OS X®: Double-click on the file with ".pkg" appended to the name. Make

sure that the default "Install for all users on this computer" is selected as the
destination for the installed software. If "Install for me only" or "Install on a
specific disk" is selected, the software will not connect to the sensor.

3. Push Run in the new window.
The setup wizard starts.

4.2 Verify sensor operation

W A R N I N G
 

Sensors that use ultraviolet light sources (< 400 nm): Do not look directly at a UV light
source when it is on. It can cause damage to the eyes. Keep products that have UV
light sources away from children, pets, and other living organisms. Wear polycarbonate
UV-resistant safety glasses to protect the eyes when a UV light is on.

1. Connect the USB or RS232 cable to the PC.
For RS232: connect the power connectors on the cable to a 8–15 VDC power supply.
For USB: a DC power supply is only necessary for data collection. If the sensor is
equipped with internal memory, the file system will show as a USB mass storage
device on the PC.

2. If necessary, start the software.
3. RS232: turn on the power supply.
4. Push Connect in the Dashboard area or at the top of the UCI window.
5. If necessary, change the "Instrument Type" to the connected sensor.
6. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
7. If necessary, select the communication port.
8. Select the UCI menu, then Preferences.
9. Push OK.

4.3 Operate wiper
If the sensor is equipped with a wiper, make sure that the wiper operates correctly.
Push Check wiper to operate the wiper for one cycle.
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4.4 Verify sensor collects data
1. Push Start in the Dashboard.

The "Connection Mode" shows "Acquisition."

• Push OK so that the software is "Temporarily Enabling Transmit Real Time
Setting..." The software shows the data as it is collected in the Time Series tab.

• The Expected Data Start window shows "You will see data in approximately xxx
seconds" and shows the time left. This lets the sensor become stable before it
starts to collect data.

2. From the View menu, select the options to see the data:

• Real Time Data—Put a check in each box next to each parameter for which the
sensor will collect data.

• Data Collection—Push Start to save the collected data to the PC.

• Time Series, Spectra, and Total Absorbance graphs.
3. Put a check in the box next to any additional parameters, so that they will show in the

Time Series graph.

4. Look at the data in the Time Series graph. The user can look at data in real-time for
each sensor that has power supplied, is connected and is in communication with the
software.

• Put a check in the box next to "Time Axis" to push Zoom In and Zoom Out to
change the scale of time.

• Put a check in the box next to "Range Axis" to push Zoom In and Zoom Out to
change the scale of the data.

• To move the data in any direction, push the "Ctrl" key on the PC keyboard and
the left button of the mouse pointer at the same time.

Set up sensor and verify operation
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• To select a specific part of the data to zoom in on, pull the mouse pointer
diagonally.

• Push Auto Range to see the data for each selected parameter. The software
adjusts the scale so that the data will always show.

• Push Default Ranges to go back to the manufacturer-set default scale for each
parameter.

• Put a check in the box next to "Show Data Points" to see the value of the
collected data when the mouse moves over each point.

• Push Select Sensors To Display to change the parameters to look at in the
Time Series graph.

5. Let the sensor or sensors collect data for approximately 5 minutes.

4.4.1 Monitor data in spectra graph
The Spectra graph shows both the dark and light data in raw counts.
The dark counts are from thermal noise. The light counts are the measured output minus
the dark counts.
The measured spectrum is always flat below 200 nm, and then has four or five peaks.
The peaks are approximately 25 nm apart in the lower wavelength range and up to 50 nm
apart in the upper range.

4.4.2 Monitor data in time series graph
The Time Series graph shows the nitrate concentration and any selected optional values.
Use this graph to replay data that is stored in the sensor.

Set up sensor and verify operation
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1. Put a check in the box next to either or both the "Time Axis" or the "Range Axis" to
enable the Zoom In or Zoom Out options.

2. Push Select Sensors either in the Spectra graph or in the Real Time Display tab to
select the parameters to see on the graph.

3. Push Configure to put a limit on or to remove the limit to the "Graph History."

4.4.3 Monitor data in absorbance graph
The Total Absorbance graph shows the calculated absorbance from 210 to 370 nm. This
graph is an alternative to the Spectra graph. The absorbance graph should be flat when a
sample of DI water is collected. The absorbance increases as absorbing species such as
nitrate and bromide are added to samples.

If necessary, push Stop.

4.5 Verify sensor transmits data

N O T I C E
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix
chemistries, V-Ah, or new and used batteries.

If the sensor is equipped with internal memory, the collected data is saved in the sensor.

1. Push Transmit Files in the SUNA Dashboard area.
The files saved by the sensor show on the right side of the new File Manager
window.

Set up sensor and verify operation
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2. Select one or more files to copy to the PC.
The manufacturer recommends that the user use a USB connection to move the files
because it is much faster.

3. Push the <- arrow to start the move.
The status shows at the bottom of the File Manager window.

4. Open the file on the PC to make sure it has all of the collected data.

Set up sensor and verify operation
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Section 5 Deployment and recovery

5.1 Attach sensor to cage
The sensor can be attached to a cage or pipe for deployment. Make sure that the sensor
is attached correctly or the sensor may be damaged. The manufacturer recommends that
the sensor operates in a horizontal orientation with the optical area pointed down to
reduce the collection of sediment and bio-fouling.
If the sensor has a wiper—

• Do not use the wiper as a handle.
• Do not attach the sensor to a cage or pipe at the wiper.
• Do not let the wiper touch any part of a cage or pipe.

1. Use cradle clamps to attach the sensor to a flat surface such as a cage.
2. Make sure that both ends of the sensor are attached to a cage or pipe. Do not leave

one end unattached, such as at the end of a pipe.
3. The user can attach the sensor to a cage with hose clamps:

• Put several layers of electrical tape around the sensor to protect the pressure
housing.

• Put clamps over the electrical tape.
4. The user can deploy the sensor in an autonomous or a logger-controlled mode.

5.2 Deployment wizard
The deployment wizard makes it easy to set up the sensor for a specific deployment.

1. Select the Operational Mode. Push Next.

• Continuous: sensor collects data continuously.
• Periodic: sensor collects data for a user-set time or number of samples at user-

set interval.
• Fixed time: sensor collects data for a user-set amount of time.
• Polled: sensor collects data as commanded by a controller.
• SDI-12: sensor collects data as commanded by a SDI-12 controller.
• APEX Float: (Deep SUNA only):sensor collects data as commanded by the

APEX float controller.
2. Select the General Settings.

a. Periodic mode: "Sample Interval" from 1 minute to 24 hours between each
sample collected. "Offset" is****

b. Select "Frame Based Operation" or "Time Based Operation."
c. Enter a value between 1–65535 for the "Frame Cycle."
d. Enter a value between 1–200 for the "Number of Measurements to Average."
e. If the sensor has a wiper: put a check in the box at "Wiper Settings" to enable the

wiper.
f. Select the "Level." "INFO" is the default. Refer to the Message tab on page 48

for details about the levels.
g. Push Next.

3. Select the Data Settings.

a. Select the "Transmitted Frame Format." FULL_ASCII" is the default.
b. Select the "File Creation Method." "By File Size" is the default. Refer to 

Communication on page 29 for details.
The manufacturer recommends that the user selects

c. Push Next.
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4. Select whether the sensor will be deployed in fresh water or seawater. Push Next.
5. Make a Deployment Report for a record of the settings stored in the sensor.

5.3 Recover sensor from deployment

W A R N I N G
 

If the user thinks that a sensor has water in the pressure housing: Disconnect the
sensor from any power supply. Put on safety glasses and make sure that the sensor is
pointed away from the body and other people. In a well ventilated area, use the purge
port (if the sensor is so equipped), or very SLOWLY loosen the bulkhead connector to
let the pressure release.

Flush the sensor with clean fresh water after each deployment.
Attach the protective dummy plug and lock collar.
Do not leave the sensor in direct sunlight.

Deployment and recovery
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Section 6 Transmit data

1. Push Transmit Data in the Dashboard area.
The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is 115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to the
default for the connected sensor.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is copied to the PC.
• The software uploads a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

6.1 Export data to .csv or MS Excel format
Data from the sensor can be saved to either a comma-separated (.csv) file or a
Microsoft® Excel file with a local or UTC time stamp. Use the software to transmit data
from the sensor and then export that data to a human-readable format.

1. From the Data menu, select Export Stored Data.
2. Push Browse to find the file to export.
3. Select the file from the list.
4. Push Open.
5. Push Next. Select the options for the file to export:

a. Select either "Excel Workbook" or "Comma Separated Values" in Export File
Format.

b. Select either the "UTC" or "Local" time stamp in Format Options.
6. Push Browse to select the directory in which the exported data will be saved.
7. Push Finish.
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6.2 Options to process data
Go to the Data menu to select how data is processed.

• Use Reprocess Data to apply a different calibration or other setting to saved data.
• Use Show Data From Sensorto show a graph of saved data.
• Use Convert APF Data to convert APF data from the from binary to full_ASCII so data

can be re-processed (2000 m sensor only.)
• Use Compare Calibration to compare two calibrations from the same sensor.

The SUNA uses the files below to process data:

• The .xml instrument package file. For Windows, this is C:\Users\%USERNAME\My
Documents\Sea-BirdScientific\SUNA. For Mac OS X, this is /Users/Home/Sea-
BirdScientific/SUNA.

• The raw data file to process.
• The calibration file for the sensor.

6.2.1 Convert SUNA raw data
The Convert SUNA raw data function has been replaced with "Transmit Data from
Sensor" in the software. Go to the Data menu and select Export Data to transmit the data
from the SUNA. Refer to Export data to .csv or MS Excel format on page 49 for details.

6.2.2 Show SUNA data
Use Show Data form Sensor to see the data that has been saved on the PC.
The SUNA uses the files below to process data:

• The .xml instrument package file. For Windows, this is C:\Users\%USERNAME\My
Documents\Sea-Bird-Scientific\SUNA. For Mac OS X, this is /Users/Home/Sea-Bird-
Scientific/SUNA.

• The raw data file to process.
• The calibration file for the sensor.

1. Push Show Data from Sensor.
2. If necessary, push Browse to find the .xml "Instrument Package File" that is saved on

the PC. A typical file is "SUNA_xxx_001.xml, where xxx is the serial number of the
sensor.

3. Push Browse to find the "SUNA Raw Data File" to see the data that is saved on the
PC.

4. Push Browse to find the current "SUNA Calibration File" on the PC. A typical file is
SUNA_xxxn.CAL, where xxx is the serial number of the sensor, and n is the
calibration version.

5. Push Finish.
The saved data shows in the Time Series tab.

6.2.3 Reprocess SUNA data
The user may find that it helps to use the Reprocess Data option under some conditions.

• The settings for the sensor were incorrect. Use the "Reprocess" option to correct for
this, such as when a sensor was deployed in seawater, but set up for fresh water.

• The data that is collected has changed over an extended deployment. Data is
processed with an updated reference spectrum file, and compared to the original
reference.

• Water temperature and salinity data are collected. These can be put together with the
spectral data from the sensor to get more accurate nitrate data (Sakamoto et al.
2009).

Transmit data
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Note that the data files collected with SDI-12 (standard sensor) do not contain spectral
data and cannot be reprocessed.

1. If necessary, start the software and supply power to the sensor.
2. Go to the Data menu, then select SUNA, then Reprocess Data.

The Reprocessing Dashboard shows.

3. Push Browse to find the package file, the reference file, and the data file. All are
required to reprocess the data.

• "Instrument Package File" is an .xml file that describes the data from the sensor.
• "Calibration File" is for the reference spectrum and the extinction coefficients of

the chemical species. Use the calibration file that matches the time during which
data was collected. Calibration files are stored in the sensor unless the user
erases them.

• "Nitrate Data Files" will show in the dashboard and the user can select some or
all to process. Spectral data, which is recorded in full ASCII, full and reduced
binary, and APF frames, is required to process nitrate data. Use the reduced
binary and APF frames to reprocess data from seawater deployments. Note that
the APF frames only let the user reprocess data that was collected with the
"integration time adjustment" turned off.

4. The user can change the "Output Directory" if necessary.
5. The reprocess operation will be faster if there is no check in the "Graph Results" box.
6. Push Process Selected File(s).

The software starts to reprocess the data.
7. Open the files on the PC.

6.2.3.1 Nitrate reprocessing details
Settings in "Processing Settings" and the "Temperature & Salinity Correction" areas do
not show until selected by the user. The user can change these settings as necessary to
get better quality data.
Processing settings

Transmit data
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• The default "Enable Raw Data Checksum Validation" is on, with a check in the box. If
it is turned off, raw data can be processed even when the checksum values have
changed after data is collected.

• The default "Fitting Range" is 216.5–240 nm. If the wavelength is shorter, seawater
typically causes extinction, and a poor signal-to-noise ratio. If the wavelength is
longer non-characterized materials can be absorbed, which causes a bias in the
processed concentrations.

• The default "Max Absorbance Threshold" is 1.3. The precision of the measured
absorbance starts to decline at this value. At 2.5 absorbance units, the precision is at
the "noise floor." The precision of the processed data is better when the low-quality
parts of the "fitting range" are not processed.

• The default Seawater Calibration has no check in the box at "Deployed in Fresh
Water." Put a check in this box if the sensor was calibrated for seawater but deployed
in fresh water. Data that was collected in seawater with a check in the "Deployed in
Fresh Water" box gives incorrect nitrate concentrations.

Temperature and salinity correction
Seawater has a temperature-dependent absorption rate. Make sure to consider this so
that imprecision does not affect the nitrate concentration that is measured. To mitigate
this effect, use the sample temperature and salinity values in the nitrate calculation in the
host software for post-processing. Note that spectra and related temperature and salinity
data is necessary. The temperature-salinity correction comes from MBARI (cf. Carole M.
Sakamoto, Kenneth S. Johnson, and Luke Coletti, Limnol. Oceanogr.: Methods 7, 2009.)
"Temperature and Salinity Correction" is available if the sensor is calibrated for seawater
and water temperature and salinity data ("T-S data") are collected. This data can come
from frames if the sensor operates in APF mode (SUNA V2 deep only), or from an
external file.

1. The default "Activate Temperature & Salinity Correction" has no check in the box. Put
a check in this box to add T-S data correction information.

2. Select either "CTD Data from SUNA APF Mode Frames" or "Data from External File"
to get T-S data from an external file. The required ASCII format is "YYYY-MM-DD
hh:mm:ss, Temperature (c), Salinity (PSU)" e.g. 2012-11-10 90:08:06,12.3,34.567.

3. Push Browse to find the file. For "External Files": at the bottom of the new window
choose either "Sea-Bird CNV Data File" or "CSV Data File" in the "Files of type:"
area. Push Open. A green check will show in the T-S Correction area of the software
when the data is loaded.

4. The data files must have the same time stamp if more than one is selected. If
necessary, put a value in the "Time Offset" area to align the time stamps.

Transmit data
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5. Put a check in either the "Single Output File" box or the "Graph Results" box in the
Output Data Files area of the dashboard.

• If the user processes more than one file, the output can be directed to a single file
of output. Otherwise, each file that is input to process will have one file of output.

6. Push Process Selected File(s).

• A graph of the processed data shows in the Reprocessed Nitrate Graph. The
upper area shows how the chemical species combine to show measured
absorbance. The lower area shows a timeline of the original and reprocessed
nitrate concentrations. Use the slider under the timeline to select one
measurement and see the concentration to the left.

6.3 Show data from multiple sensors
The software lets the user show data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to look at.

1. Go to the Data menu, then Show Data from Sensor.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors to Show.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.
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Section 7 Maintenance

W A R N I N G
 

If the user thinks that a sensor has water in the pressure housing: Disconnect the
sensor from any power supply. Put on safety glasses and make sure that the sensor is
pointed away from the body and other people. In a well ventilated area, use the purge
port (if the sensor is so equipped), or very SLOWLY loosen the bulkhead connector to
let the pressure release.

7.1 Sensor maintenance
Although the sensor is built for deployment in severe conditions, it is important to clean
the sensor after each deployment and weekly (if deployed frequently) or monthly to
prevent fouling. After every deployment, make sure to:

1. Attach a clean and lubricated dummy plug and a lock collar to the sensor.
2. Rinse the sensor with fresh clean water.
3. Flush the optical area with fresh clean water.
4. Dry the sensor.

Use a soft towel or blow with air.
5. Put the sensor in the manufacturer-supplied case for transport or storage.

7.2 Clean bulkhead connectors

N O T I C E
 

Do not use WD-40® or petroleum-based lubricant on bulkhead connectors. It will cause damage to
the rubber.
Damaged connectors can cause a loss of data and additional costs for service.
Damaged connectors can cause damage to the sensor and make it unserviceable.
Use silicone-based lubricants only.

Examine, clean, and lubricate bulkhead connectors at regular intervals. Connectors that
are not lubricated increase the damage to the rubber that seals the connector contacts.
The incorrect lubricant will cause the failure of the bulkhead connector.

1. Apply isopropyl alcohol (IPA) as a spray or with a nylon brush or lint-free swab or
wipes to clean the contacts.

2. Flush with additional IPA.
3. Shake the socket ends and wipe the pins of the connectors to remove the IPA.
4. Blow air into the sockets and on the pins to make sure they are dry.
5. Use a flashlight and a magnifying glass to look for:

Any corrosion.

Cracks, scratches, or other damage on the
rubber pins or in the sockets.
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Separation of the rubber from the pins.

Swelled or bulging rubber pins.

6. Use a silicone-based lubricant on each of the contacts of the bulkhead connector.
The manufacturer recommends any of the products listed below.

• 3M™ Spray Silicone Lubricant (3M ID# 62-4678-4930-3). Make sure to let it dry.
• Dow Corning Molykote® III Compound (DC III)
• Dow Corning High Vacuum Grease® (DC 976 V)
• Dow Corning 4 Electrical Insulating Compound® (DC 4)
• Dow Corning Molykote 44 High Temperature Grease® (DC 44)

Use a finger to put a small quantity (approximately 1 cm in diameter) of silicone
grease on the socket end of the connector and push as much of the lubricant as
possible into each socket. Do not use too much lubricant, as that will prevent a good
seal.

7. Connect the connectors.
8. Use a lint-free wipe to clean any unwanted lubricant from the sides of the connectors.

7.3 Update reference spectrum
The user needs to update the reference spectrum of the SUNA at regular intervals so that
the sensor collects accurate data. It may also be necessary to update the firmware,
although that is not required very frequently.
A calibration file contains the data required to convert a spectral measurement into a
nitrate concentration. The calibration data are the wavelengths of the spectrum, the
extinction coefficients of chemical species and a reference spectrum relative to which the
measurement is interpreted. The sensor can store many calibration files, but only the
active file has a green background. Push Transmit Files > File Manager, then select the
Calibration Files tab to see the list of calibration files stored in the sensor.
Make sure to clean the sensor and the sensor windows at regular intervals and before
and after every deployment. Monitor the spectral intensity of the lamp. Although the
intensity will decrease over time, make sure there are no sudden changes.
Necessary supplies:

• Power supply
• PC with software
• Connector cable for sensor–PC–power supply
• Clean de-ionized (DI) water
• Lint-free tissues
• Cotton swabs

Maintenance
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• Isopropyl alcohol (IPA)
• Parafilm® wrap

Notes

• Use only lint-free tissues, OPTO-WIPES™, or cotton swabs to clean the optical
windows.

• Use the software to update the reference spectrum.
• Use only clean DI water that has been stored in clean glassware.
• Use Parafilm® wrap to capture DI water in the optical area of the sensor. Do not use

cups, a bucket, or a tank to collect a reference sample.

1. Clean the sensor:

a. Flush the sensor and the optical area with clean water to remove debris and
saltwater.

b. Clean the metal parts external to the optical area so that the Parafilm® will seal.
c. Std. SUNA only: If the sensor is equipped with a wiper, carefully move it away

from the optical area.

Figure 1  Parafilm® to be wound around optical area

2. Cut and stretch a length of approximately 40 cm (16 in.) of Parafilm®.
3. Wind several layers of the Parafilm® around the metal near the optical area.

Figure 2  Parafilm® on optical area

4. Break a small hole in the top of the Parafilm® and fill the optical area with DI water.
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Figure 3  Optical area filled with DI water

5. Supply power to the sensor and start the software if necessary.
6. Make sure that the sensor operates in Continuous mode: push Settings, then in the

General tab, select "Continuous" for the "Operational Mode."
7. Push Start.

• Push Start to save approximately one minute of data to the PC.
8. Push Stop.

The sensor stops data collection.
9. Open the data file on the PC and calculate the average measurement value.

This is a "dirty" measurement to record the value when there are biofouling and
blockages in the optical area.

10. Remove the Parafilm® and drain the water from the optical area.
11. Clean the optical area:

a. Use DI water or IPA and cotton swabs and lint-free tissues to clean the windows.
b. Use vinegar to clean debris such as barnacles. Be careful that the windows do

not get scratches.
12. Flush the optical area with DI water to remove any remaining IPA or vinegar.
13. Wind the Parafilm® around the metal near the optical area.
14. Break a small hole in the top of the Parafilm® and fill the optical area with fresh DI

water.
15. Supply power to the sensor and start the software if necessary.
16. Push Reference Update.

The "Reference Update Wizard" shows.
17. Fill the sample volume with distilled water. Refer to the hardware user manual for

details.
18. Make sure the "Operational Mode" is set to "Continuous," then push Next.
19. The sensor starts to collect data. This will take approximately 30 seconds.
20. Push Next.
21. Look at the graph to see the change between reference spectra.
22. Push Next.
23. Push Browse to select a directory in which to save the Calibration Report.
24. Optional: write a comment.
25. Put a check in the "View" box to automatically open the new report.
26. Put a check in the "View" box to automatically open the new calibration file.
27. Push Finish.

The software makes a report and a calibration file.
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7.4 Compare reference spectrum files
Compare the change between two reference spectrum files. The amount of change is
related to the time interval between the updates and the amount of lamp use during that
time.
Note that this procedure is done automatically by the software when the user updates the
reference spectrum for the sensor. Refer to Update reference spectrum on page 24 for
more information.

1. From the Data menu, select SUNA, then Compare Calibration.
2. Push Browse to find the first calibration, or reference file, to compare.
3. Push Browse to find the second file to compare. Note that the files must be from the

same sensor.
4. Push Compare.

A typical update interval of 3–6 months with no more than 100 hours of lamp use
should cause a change of no more than 10% in the 215–240 nm interval.
Below 215 nm, larger relative changes are normal.
Above 240 nm, the change is smaller than at the 215–240 nm range.
If there is a large change, do several reference updates 12–24 hours apart to monitor
the stability of the reference spectrum.

7.5 Update SUNA firmware
At regular intervals, make sure that the current firmware is installed in the sensor.

1. Go to the manufacturer's web site to get the current firmware for the sensor.
2. Save the firmware to the PC.

The firmware is an ".sfw" file.
3. Make sure that the sensor is connected to the PC and a power supply.
4. Push Connect.
5. Go to the Sensor menu and select SUNA, then Advanced, then Upload Firmware

File.
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6. Push Browse to find the firmware file that is saved on the PC.
7. Push Open.
8. Push Upload.

It takes approximately 2 minutes for the software to be updated. The software
disconnects the sensor.
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Section 8 Reference

8.1 Communication
Go to the Telemetry tab in SUNA Settings to set up communication and data file types.
The default serial baud rate is 57600.
The default for "Transmitted Frame Format" and "Data Format" is "FULL_ASCII."

• FULL_ASCII—Contains all collected data in comma-separated fields. The file
extension is .csv. The frame size is typically 1600–1800 bytes. Use this format so
that data can be reprocessed.

• NONE—For "Transmitted Frame Format" data output is turned off. For "Data Format"
sensor data storage is turned off.

Other available formats:

• FULL_BINARY—Contains all collected data. The file extension is .bin. The frame
size is 632 bytes. Use this format so that data can be reprocessed.

• REDUCED_BINARY—Contains data from part of the spectrum and data from some
auxiliary sensors. The file extension is .bin.The frame size is 144 bytes. Use this
format so that seawater data can be reprocessed.

• CONCENTRATION ASCII—Contains a time-stamp, nitrate concentration,
absorbance at 254 and 300 nm and Root Mean Square Error (RMSE) to measure the
quality of the data. The file extension is .csv.

• APF—Deep SUNA V2 only. Used for APEX floats. Contains the user-selected parts
of the spectrum and other auxiliary sensors. The frame size is typically
300–400 bytes.

• The user can set the "Transmitted Frame Format" to "NONE" to turn off data output.
This increases the rate at which data is collected, and uses 10–30% less power.

• The user can set the "Frame Format" to NONE to turn off internal data collection.

The default "File Creation Method" is "By File Size." Others are available:

• By File Size—The software makes a new file when the data file in use gets to the
user-selected maximum size. The file name starts with "C" ("Continuous" file).

• By Sample Event—The software makes a new file when data collection starts for the
first time after the power has been turned off, then on. The manufacturer
recommends that the user select this for test purposes only. Use of this setting can
result in so many stored files that the sensor operates slowly or incorrectly. The file
name starts with "A" ("Acquisition" file).

• Daily—All data that is collected during a calendar day is put into a single file. This file
name is a seven-digit number that is the year and the day of the year, for example,
D2015142.csv. The file name starts with "D" ("Date-stamped" file).

The default "Maximum File Size" is 2 MB when the "Mode of Operation" is set to
"Continuous." It is user-selected from 1–65 MB. The "Daily" and "Sample Event" files
contain all of the data that is collected during the day or during one cycle of operation.

8.1.1 File types
The sensor uses three types of files:

• Data—either ASCII (.csv), or binary (.bin).
• Calibration—reference spectrum updates from the manufacturer (.cal).
• Log—information about the sensor (.log)

Table 3  Information in data files 
Column Data type Full ASCII Full Binary

1 Date, yyyy-mm-dd
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Table 3  Information in data files (continued)
2 Header and serial number N/A

3 Date, year and day-of-year AI7 BS 4

4 Time, hours of day AF BD 8

5 Nitrate concentration, µM AF BF 4

6 Nitrogen in nitrate, mgN/L AF BF 4

7 Absorbance, 254 nm AF BF 4

8 Absorbance, 350 nm AF BF 4

9 Bromide trace, mg/L AF BF 4

10 Spectrum average AI BU 2

11 Dark value used for fit AI BU 2

12 Integration time factor AI BU 1

13–268 Spectrum channels 256 x AI 256 x BU 2

269 Internal temperature, °C AF BF 4

270 Spectrometer temperature, °C AF BF 4

271 Lamp temperature, °C AF BF 4

272 Cumulative lamp on-time, secs AI BU 4

273 Relative humidity, % AF BF 4

274 Main voltage, V AF BF 4

275 Lamp voltage, V AF BF 4

276 Internal voltage, V AF BF 4

277 Main current, mA AF BF 4

278 Fit aux 1 AF BF 4

279 Fit aux 2 AF BF 4

280 Fit base 1 AF BF 4

281 Fit base 2 AF BF 4

282 Fit RMSE AF BF 4

283 if CTD: Time, secs AI BU 4

284 if CTD: Salinity, PSU AF BF 4

285 if CTD: Temperature, °C AF BF 4

286 if CTD: Pressure, dBar AF BF 4

287 Check sum AI BU 1

Terminator <CR><LF> —
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8.1.2 Continuous and fixed-time operation

The sensor must regularly collect a dark spectrum measurement so that it has a baseline
correction for changes in time or "drift" in the output of the spectrometer.
The user can set up the sensor to collect a dark spectrum measurement on a time-based
or measurement-based schedule. A typical setup is a 1-second dark spectrum
measurement for each 20–30 seconds (20–30 measurements) of the light spectrum.

8.1.3 Logger-controlled operation
Use the software to see and change the settings for this mode of operation.

Use the commands below to communicate with the sensor in RS232.

Command Result

Start Start continuous data collection.
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$ Stops the sensor data collection.

Measure N The sensor gets "n" light data frames. If "n" is zero, the sensor gets one dark data frame.

Timed N The sensor gets light data frames for "n" seconds.

CTD The sensor sends CTD data to be corrected for temperature and salinity. The sensor must be set up to do the
correction and to process it.

Status Print the status of the sensor.

Sleep The sensor goes to low power standby mode.

Data files are saved in "FULL_ASCII."
Note: "Polled" and "Logger-controlled" are both terms for the same mode of operation.

8.1.4 Periodic operation
Use the software to see and change the settings for this mode of operation.

1. Select a "Sample Interval" from the drop-down menu.
2. Look at the "Offset" value. An offset value of 300 (5 min) changes the start time by

five minutes, for example, from 06:00 to 06:05.
3. The "Light Frames" value is 0–255.

Data is collected for either a user-selected quantity of time or a user-selected number of
measurements.
Note: "Periodic" and "Autonomous" are both terms for the same mode of operation.

8.1.5 Data acquisition monitor
The software monitors the data collected by the sensor and shows any errors in this
window. The error counters are reset each time the sensor starts a new data collection
file. All information is transmitted during data collection, in real-time.
To see this tab, go to the View menu and select Acquisition Monitor.
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• Frame Id—the unique frame number.
• Read—The number of frames accepted.
• Errors—The number of frames discarded.
• Checksum Errors—There may be a problem with the data that is transmitted.

Examine the cabling and connectors. If the value in such is frame is wrong, it is
discarded. If the collected data is saved to the internal memory of the sensor, that
data is correct and can be copied to the PC at a later time.

• Counter, Status, and Fitting Errors—always zero.

8.1.6 Analog operation
The SUNA V2 is optionally equipped at the manufacturer's facility with analog output
capabilities so that the sensor can work with analog input data collection systems such as
the SBE 19Plus V2, 25Plus, and 9Plus CTDs. A standard application integrates the
voltage signal into the auxiliary port of a CTD to get a profile of conductivity, temperature,
and nitrate vs. depth.
To find out if a sensor has analog output, go to the Sensor menu, then Advanced. The
DAC calibration function is available if the sensor has analog output.
The sensor gives voltage and current output of the calculated nitrate values. A 12-bit
digital-to-analog converter (DAC) is used to give a voltage range of 0.095–4.095. A 16-bit
DAC gives a current range of 4–20 mA.
The sensor has two configuration values: DAC minimum nitrate and DAC maximum
nitrate that are the lowest and highest values for voltage and current output. Nitrate
values lower than the minimum or higher than the maximum are calculated:
V = Vmin + [(Vmax - Vmin) / (DACmax - DACmin)] × (Cnitrate - DACmin)
I = Imin + [(Imax - Imin) / (DACmax - DACmin)] × (Cnitrate - DACmin)

where—

Cnitrate Nitrate concentration

DACmin Nitrate concentration at minimum voltage and current

DACmax Nitrate concentration at maximum voltage and current

V Voltage from sensor

Vmin Minimum voltage, 0.095 V

Vmax Maximum voltage, 4.095 V

I Generated current

Imin Minimum current, 4 mA

Imax Maximum current, 20 mA

Calculate nitrate concentration from voltage and current
The inverse voltage and current calculations are shown below.
Cnitrate = DACmin + [(DACmax - DACmin) / (Vmax- Vmin)] × (V - Vmin) and
Cnitrate = DACmin + [(DACmax - DACmin / (Imax- Imin)] × ( I - Imin )
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These equations can also be written as:
Cnitrate = A0 + A1 × V, and
Cnitrate = B0 + B1 × I

where—

A1 = (DACmax - DACmin) / (Vmax- Vmin) is the voltage scale coefficient

A0 = DACmin - A1 × Vmin is the voltage offset coefficient

B1 = (DACmax - DACmin) / (Imax- Imin) is the current scale coefficient

B0 = DACmin - B1 × Imin is the current offset coefficient

Calibrate the sensor in-system
The voltage and current values in a deployed system may be different from the nominal
values and should be used instead.

1. Use a Y-cable to connect the sensor to the data collection device and a PC.
2. Select the Sensor menu, then Advanced, then DAC Calibration. Push Low, then

High, to get the analog output for the lower, then upper values of the nitrate DAC
range.

3. Use these values to calculate the in-system scale and offset coefficients.

A1 = (DACmax - DACmin) / (Vhigh- Vlow) is the in-system calibrated voltage scale coefficient

A0 = DACmin - A1 × Vlow is the in-system calibrated voltage offset coefficient

B1 = (DACmax - DACmin) / (Ihigh- Ilow) is the in-system calibrated current scale coefficient

B0 = DACmin - B1 × Ilow is the in-system calibrated current offset coefficient

8.2 SDI-12 operation
Note: SDI-12 operation is not available on SUNA V2 deep sensors.

The manufacturer-set address of the SDI-12 is numerical value 48 (ASCII character 0).
The SDI controller uses this address to interface with the sensor in an SDI-12 mode of
operation. The user can change this value in the SDI controller.
Note: "Polled" and "Logger-controlled" are both terms for the same mode of operation. The sensor
supports all basic SDI-12 commands. Refer to the SDI-12 specification at www.sdi-12.org for details
of the command protocol. For any command not described below, the sensor will respond
according to the SDI-12 v1.3 specification.

Definitions:

• All commands are case-sensitive
• "a" is the SDI-12 address of the sensor (default is "0")
• <CRC> is the 3-character Cyclic Redundancy Check
• <CR> is a Carriage Return character
• <LF> is a Line Feed character

Acknowledge Active (a!)

Response a<CR><LF>

Purpose verifies the SDI-12 address

Example address = 0 

SDI recorder sends 0!

sensor sends 0<CR><LF>
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Address query (?!)

Response a<CR><LF>

Purpose shows the SDI-12 address

Example address = a

SDI recorder sends ?!

sensor sends a<CR><LF>

Change address (aAb!)

Response b<CR><LF>

Purpose changes SDI-12 address to "b". The default address is 0.

Example address = 0 

SDI recorder sends 0A1!

sensor sends 1<CR><LF>

address now = 1 

Verify (V!)

Response attn<CR><LF>

Purpose The sensor always responds with a0000<CR><LF> . No diagnostic information is supported.

Send identification (aI!) ("a, capital I, !)

Response allccccccccmmmmmmvvvxxxxxxxxxx<CR><LF>

a = sensor address

Il (lowercase "L") = 2-character SDI-12 version. For example, "13" for version 1.3 

cccccccc = 8-character manufacturer identification. For example, "SATLANTC"

mmmmmm = 6-character sensor model. For example, "SUNA"

vvv = 3-character sensor version. For example, "v2"

xxxxxxxxxxxxx = up to 13-character optional field. Format: F<MAJOR>.<MINOR>.<PATCH>
Used for firmware by the manufacturer.

Example 013SATLANTC SUNA v2 0002F2.1.2<CR><LF>

Start Measurement (aM!)
Start Measurement and Request CRC (aMC!)
Start Concurrent Measurement (aC!)
Start Concurrent Measurement and Request CRC (aCC!)

Response atttn<CR><LF>
atttnn<CR><LF>

Purpose starts a measurement.
starts a concurrent measurement.

Notes a = address = (0–9)

ttt = measurement time in seconds. The sensor typically responds in less than 30 seconds.

n or nn. The number of measurement values the sensor makes and returns after subsequent Send
Data commands. Value = 4.
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Example 00104<CR><LF> measurement
001004<CR><LF> concurrent measurement

The sensor reports that 10 seconds are required to do the measurement. Typically it will complete
sooner and send a service request to the controller.

In subsequent data commands, the four values are—
nitrate concentration µM
nitrogen in nitrate concentration mgN/L
light spectrum average
dark spectrum average

Additional Measurement (aM1!)
Additional Measurement and Request CRC (aMC1!)
Additional Concurrent Measurement (aC1!)
Additional Concurrent Measurement and Request CRC (aCC1!)

Response atttn<CR><LF>
atttnn<CR><LF>

Purpose starts a measurement.
starts a concurrent measurement.

Notes a = address = (0–9)

ttt = measurement time in seconds. The sensor typically responds in less than 30 seconds.

n or nn. The number of measurement values the sensor makes and returns after subsequent Send
Data commands. Value = 7.

Example 00067<CR><LF> measurement
000607<CR><LF> concurrent measurement
where 00067 is the address (0), the measurement time (006), and the number of measurements (7).

Example output from the controller:

00M1!
0D0!
0D1!

00067 <CR><LF>
0+22.7+22.5+141779+46.8<CR><LF>
0+12.0+5.0+14.0<CR><LF>

Example output from the controller for the seven values—
Example output values in parentheses:
lamp temperature, °C (22.7)
spectrometer temperature, °C (22.5)
lamp time, seconds (141779)
relative humidity, % (46.8)
internal voltage, V (12.0)
regulated voltage, V (5.0)
supplied voltage, V (14.0)

Additional Measurements (aM2!)
Additional Measurements and Request CRC (aMC2!)
Additional Concurrent Measurement (aC2!)
Additional Concurrent Measurement and Request CRC (aCC2!)

Response atttn<CR><LF>
atttnn<CR><LF>

Purpose starts a measurement.
starts a concurrent measurement.

Notes ttt = measurement time in seconds. The sensor typically responds in less than 30 seconds.
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n or nn. The number of measurement values the sensor makes and returns after subsequent Send
Data commands. Value = 7.

Example 00099<CR><LF> measurement
000913<CR><LF> concurrent measurement

Example output from the controller:

00M2!
0D0!
0D1!
0D2!

00099 <CR><LF>
0+3.26+0.0457+15501+721<CR><LF>
0+2015033+20.57608<CR><LF>
0+0.132+0.0672+0<CR><LF>

Example output from the output for the nine (or 13 for concurrent) values—
Example output values in parentheses:
nitrate concentration, µM (3.26)
nitrogen in nitrate concentration, mgN/L (0.0457)
light spectrum average (15501)
dark spectrum average (721)
measurement date (2015033)
measurement time (20.57608)
absorbance at 254 nm (0.132)
absorbance at 350 nm (0.672)
bromide trace (0)
lamp temperature, °C (concurrent measurement only)
spectrometer temperature, °C (concurrent measurement only)
relative humidity, % (concurrent measurement only)
rmse of nitrate processing (concurrent measurement only)

Additional Measurements (aM3–aM9!)
Additional Measurements and Request CRC (aMC3!–aMC9!)
Additional Concurrent Measurement (aC3!–aC9!)
Additional Concurrent Measurement and Request CRC (aCC3!–aCC9!)

Response atttn<CR><LF>
atttnn<CR><LF>

Purpose starts a measurement.
starts a concurrent measurement.

Notes The sensor supports 2 additional measurements.
ttt = 000 
n = 0 
nn = 00 

"Send Data" commands that come after the aM! or aMC! commands:

Send Data (aD0!–aD9!)

Response a<values><CR><LF>
a<values><CRC><CR><LF>

Purpose sends data to the SDI controller after a measurement or verification command. The response depends
on the previous measurement command.

Note after the M! or C! command the sensor responds with nitrate concentration in two units, and the light
and dark spectrum average.

Example 0+1039.040+14.8434+22799+671<CR><LF>
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Note after the MC! or CC! command the sensor responds the same as M! or C! but with a CRC value
attached.

Example 0+1038.188+14.8350+22683+672NtW<CR><LF>

Note after the MC! or CC! command the sensor responds to the aD0! command temperature in two units,
lamp time, and humidity.

Example 0+33.188+23.500+3356+23.2AsF<CR><LF>

Note The sensor responds to the aD1! command with three voltage units.

Example 0+11.92+5.43+13.68<CR><LF>

after the MC1! command the sensor responds as in the M!! command, but with a CRC value attached.

Example 0+33.813+23.500+3356+23.2AsF<CR><LF>
followed by: 0+11.92+5.43+13.62EyF<CR><LF>

The response to the aC1!, aCC1!, aM2!, aMC2!, aC2!, aCC2! commands is similar.

Continuous Measurement (aR0!–aR9!)
Continuous Measurement and Request CRC (aRC0!–aRC9!)

Response a<values><CR><LF> or a<values><CRC><CR><LF>

note the Continuous Measurement command is not supported due to the limited life of the lamp. The sensor
reports a0<CR><LF> or a0<CRC><CR><LF>

8.3 Terminal program
The user can communicate with the sensor through the manufacturer-supplied software,
or by use of a terminal program through the serial port on a PC. Examples of terminal
programs include PuTTY, Tera Term, and Bray.
When power is supplied to the sensor, the sensor goes into a low-power "standby" mode.
Any activity on the input line puts the sensor to the "SUNA>" command interface within
three seconds. The sensor returns to low-power standby after a user-selected period of
time with no communication.

1. Connect the serial cable to the sensor and the PC.
2. Connect the serial cable to an 8–15 VDC, 1 A minimum, power supply.
3. Start a terminal program.

a. Set up the communication values if necessary: 8 bit, no parity, 1 stop bit, no flow
control.

b. Go to Setup, then Serial Port.
c. If necessary, change the baud rate to 57600. Push OK.
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4. Turn on the power supply.
5. Send one or more "$" commands to the sensor to see a prompt at the command line.

The sensor shows "SUNA>" when it is ready to accept commands.
6. Type "get opermode" to see the current mode of operation for the sensor.

The default value is Fixed Time. It shows as "fixedtime." Refer to Data collection
setup values on page 40 for other values for modes of operation.

Table 4  Status commands
Description Command Result

Selftest selftest Makes sure the sensor operates correctly, does measurements, and sends those
measurements as the last line of output.
$Ok—the sensor operates correctly.
!—A sensor component did not operate correctly.
$Error—A sensor component did not pass the test.

Used lamp time get lamptime The total time the lamp has operated, in seconds.

Current
configuration

get config The sensor shows the current setup configuration.

Get mode of
operation

get opermode The sensor shows the current mode of operation.

Set mode of
operation

set opermode Changes the mode of operation

7. To change the mode of operation to SDI-12:

a. Make sure that the sensor is so equipped. Type "getopermodesdi12brd"
The response is "available." If the response is "missing", the sensor is not
equipped with SDI-12.

b. Type "set opermode sdi12" to change the mode of operation to SDI-12.

c. Type "get opermode" to make sure that the sensor is in SDI-12 mode.
8. Use the SDI-12 controller to communicate with the sensor when it is in SDI-12 mode.

8.3.1 Input-output configuration values
Parameter Possible values Default value Short name

Baud rate 9600, 19200, 38400, 57600, 115200 57600 baudrate

Message level Error, Warn, Info, Debug Info msglevel

Message file size (MB) 0–65 2 msgfsize

Data file size (MB) 1–65 5 datfsize

Data file type acquisition, continuous, daily acquisition logftype
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Acquisition file duration (min) 0–1440 60 afiledur

Data wavelength, low (nm) 210–350 217 wdat_low

Data wavelength, high (nm) 210–350 250 wdat_hgh

8.3.2 Data collection setup values
Parameter Possible values Default value Short name

Operation mode continuous, fixedtime, periodic, polled, SDI12 fixedtime opermode

Operation control duration, samples samples operctrl

Countdown (sec) 0–3600 3 countdwn

Fixed time duration (sec) 1–1000000 10 fixddura

Periodic interval 1, 2, 5, 6, 10, 15, 20, 30 (min);
1, 2, 3, 4, 6, 8, 12, 24 (hr)

1 hr perdival

Periodic offset (sec) any value 0 perdoffs

Periodic duration (sec) 0–255 10 perddura

Periodic samples (# light frames) 0–255 10 perdsmpl

Polled timeout (sec) 0–65535 10 polltout

Skip sleep at startup on, off off skpsleep

Lamp stability time (ds) ? 0–255 5 stbltime

Lamp switch-off temperature (°C) * (see note below) 35 lamptoff

Spectrometer integration period (msec) 5–60000 N/A spintper

Dark averages 1–200 1 drkavers

Light averages 1–200 1 lgtavers

Dark samples 1–65535 1 drksmpls

Light samples 1–65535 10 lgtsmpls

Dark duration (sec) 1–65535 10 drkdurat

Light duration (sec) 1–65535 120 lgtdurat

External device none, wiper none exdevtyp

Ext. dev. pre-run time (sec) 1–120 0 exdevper

Ext. dev. during collection on, off off exdevrun

Ext. dev. minimum interval 1–1440 60 exdvival

Periodic Mode of Operation: When power is supplied to the sensor, the sensor goes to a
low-power standby mode. Any activity on the input line puts the sensor to the "SUNA>"
command interface within three seconds. The sensor returns to low-power standby after a
user-selected period of time with no communication.
Continuous Mode of Operation: Data is collected continuously and autonomously when
power is supplied to the sensor. Data collection stops when the user removes power or
enters a "$" character.
Fixed-time Mode of Operation: data collection occurs for the time set up by the user.
When that time is completed, the sensor enters a low-power standby.
Polled Mode of Operation: the sensor is in low power standby mode until there is activity
on the input line. The sensor initializes in 3–4 seconds, then displays a "CMD?" prompt to
show that is it is ready to receive commands from the controller. The "timeout" value
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controls the length of time the sensor is in standby mode before it returns to low power
standby mode.
For best accuracy, regular dark measurements are necessary to compensate for the
change in temperature. Select a dark-to-light data collection rate based on either the
number of samples or the duration.
Note: 
The lamp turn-off temperature is 35 °C. The lamp should not operate at temperatures above 35 °C.
When the lamp reaches the turn-off temperature, the sensor overrides the user-configured mode of
operation. The sensor does 5 cycles of 5-light to 5-dark sample collection, then does 1-light to 10-
dark cycles until the lamp temperature is below the turn-off temperature.
Contact the manufacturer for information to safely change the turn-off temperature.

8.4 Theory of operation
8.4.1 Background

The SUNA is a chemical-free nitrate sensor for fresh, brackish, and salt water. The
sensor is based on the In-Situ Ultraviolet Spectroscopy (ISUS) that was developed at
MBARI (cf. Kenneth S. Johnson, Luke J. Coletti, Deep-Sea Research I, 49, 2002,
1291–1305).
The sensor lights the water sample with its deuterium UV light source and measures this
with its spectrometer. The difference between this measurement and a prior baseline
measurement of pure water is the absorption spectrum.
Absorbance characteristics of natural water components are in the calibration file of the
sensor. The Beer-Lambert law for multiple absorbers makes the relationship between the
total measured absorbance and the concentrations of individual components. Based on
this, the sensor gives a best estimate for the nitrate concentration with multi-variable
linear regression.
If the "Integration Time Adjustment" configuration parameter is set to "On" or "Persistent,"
the sensor makes measurements with a spectrometer integration time that is 20 times as
long as the normal integration time. This increases the signal-to-noise ratio in faint light
conditions and lets the sensor operate in optically dense conditions. When the optical
density decreases, the sensor goes back to the normal spectrometer integration time.

8.4.2 Description of nutrient units
Nutrient units express the amount of something, usually moles or mass, relative to the
volume it is in. Many researchers and scientists use micromoles per liter (µM/L), a unit
that is independent of mass and useful for stoichiometric calculations.
Most fresh water monitoring programs and many researchers use units of milligrams per
liter. This unit is almost always expressed as milligrams of relevant atoms per liter—for
example, milligrams of nitrogen (N) per liter, rather than milligrams of nitrate per liter.
Although nitrate, NO3, is the most prevalent form of nitrogen, this unit is frequently used
as a means of easily keeping track of total nitrogen loading. Because milligrams per liter
is a mass-based unit and the mass of N and NO3 are different, this difference is very
important to prevent mistakes. Milligrams per liter is also typically referred to as parts per
million (ppm), the mass of N relative to the mass of water.
The SUNA V2 sensor measures dissolved nitrate and displays units in micromolar (µM)
or milligrams of nitrogen per liter (mg/N/L). The SUNA V2 does not display milligrams of
nitrate per liter (mg/L or mgNO3/L ).

8.4.3 Nitrate concentration
Nitrate processing uses the 217–240 nm wavelength range, which is approximately
35 spectrometer channels. The precision of the nitrate concentration is related to the
number of absorbers into which the measured absorbance is decomposed. High
absorbance conditions introduce inaccuracies into the nitrate concentrations. Channels
with an absorbance of more than 1.3 are not included in the processing. If less than
approximately 10 channels remain, the sensor cannot give a nitrate concentration. The
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user can increase the absorbance cutoff and get decreased-accuracy nitrate
concentration at higher absorbances.

8.4.4 Description of adaptive sampling
The SUNA V2 has a 256-channel spectrometer that integrates for a specific length of
time, usually 300–500 ms, to maximize the signal while it collects data. When the sensor
makes a measurement, the spectrograph collects UV light for the length of the integration
period. In optically dense waters, with high turbidity or CDOM, very little UV light is
transmitted through the water, so the spectrometer "sees" a much lower signal. The
SUNA V2 automatically increases the integration period to compensate for the low light,
so the sensor has a strong signal in extreme environmental conditions.

8.4.5 Sensor calibration from manufacturer
Sensors come from the manufacturer with a default class-based calibration. Sensors can
have an optional sensor-specific calibration for either fresh water or seawater. The user
can configure a seawater calibration for either fresh water or seawater.
The calibration file is stored in the sensor and includes the coefficients to calculate nitrate,
as well as a reference spectrum. The software has a wizard to let the user update the
reference spectrum at regular intervals or as necessary. This procedure adjusts the
"zero" nitrate value based on a sample of pure water (ultra pure, nano pure, or DI).The
user must periodically update the reference spectrum to make sure that the sensor
collects accurate data because the optical components change over time..
For best performance, send the sensor back to the manufacturer annually for
maintenance.

8.5 Interferences and mitigation
8.5.1 Uncharacterized species in sample

A number of substances in natural water absorb in the UV spectral range where nitrate
absorbs. The spectral signature is usually different from nitrate but certain combinations
of water components may cause a bias in the calculated nitrate concentrations.
If the user thinks there are significant concentrations of interfering species, do a random
spectral and chemical analysis of the water sample to quantify and correct the optical
interference.

8.5.2 Optically dense constituents
The performance of the sensor is compromised in optically dense conditions, which
transmit less light than necessary for the regression analysis. As the optical density
increases, the quality of the measurement (signal-to-noise) decreases. The accuracy and
precision of the nitrate concentration measurements decrease as the quality of the data
decreases. High optical densities are frequently caused by CDOM/turbidity in the water
sample.

8.5.3 Identification of interfering species
The effect of turbidity and CDOM on the measured nitrate concentration was calculated in
the laboratory.

Turbidity sample NTU per
mg/L

Absorbance at
225 nm (10 mm)

per mg/L

NO3 change, µM, in
freshwater per mg/L

NO3 change, µM, in
seawater per mg/L

Arizona Road Dust (ARD) 1.25 0.0016 < -0.002 (-2.8  e -5) 0.01 (1.4  e -4)

Kaolin powder 1.5 0.0085 < 0.001 (1.4  e -5) 0.02 (-2.8  e -4)

Titanium dioxide (TiO2) 15.0 0.0090 < 0.001 (1.4  e -5) < 0.001 (1.4  e -5)
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CDOM sample QSD per mg/L
particle

Absorbance at
225 nm (10 mm) per

mg/L particle

NO3 change, µM, in
seawater per mg/L

particle

NO3 change, µM, in
seawater per mg/L

particle

Pony Lake Fulvic Acid
reference (1R109F)

N/A 0.017 0.4 (5.6  e -3) 0.6 (8.4  e -3)

Suwannee River Fulvic Acid
standard (1S101F)

N/A 0.027 < 0.1 (1.4  e -3) < 0.1 (1.4  e -3)

Pahokee Peat Humic Acid
reference (1R103H-2)

42 0.003 < 0.01 (1.4  e -4) < 0.1 (1.4  e -3)

An interfering species causes an incorrect nitrate concentration when its spectral
characteristics are almost the same as nitrate. The root mean square error (RMSE) value
is the square root of the mean of the sum of the squared differences between the
measured and the fitted absorbance. The RMSE is a measure of the quality of the fit.
Independent measurements of turbidity and CDOM, and an analysis of the absorption
spectrum help the impact analysis.

8.5.4 Sensor function
The lamp and other optical components in the sensor change with time. This causes
nitrate measurements to change, or "drift." Do regular updates to the reference, or
baseline, spectrum to minimize this change.
The output of the lamp is related to its temperature. The manufacturer recommends that
the user collect the reference (baseline) spectrum in conditions that are almost the same
as a deployment.

8.6 CDOM absorption
Figure 4  Fulvic acid, mg/L

Note that the CDOM spectral shape overlaps with the nitrate processing region.
The model to calculate nitrate fits for four parameters: nitrate, bromide, a temperature
coefficient and a linear baseline correction that accounts for all additional absorbing
species. If the absorption of the sample is high (default cut-off = 1.3 AU), the model can
no longer be used effectively to fit parameters or calculate nitrate concentration. The
SUNA V2 data output is an RMSE parameter that indicates the quality of the fit of the
models to the absorption curves.
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CDOM absorption properties
Colored Dissolved Organic Matter (CDOM) is one of the main substance classes that
absorbs in the same UV range as nitrate. (Other significant absorbers are seawater,
bromide, bisulfite, and suspended particles). CDOM is a mixture of many chemicals, and
changes across locations and times, usually depending on its origin. Thus, there is no
universal characterization of the UV absorption of CDOM.
CDOM impact on SUNA nitrate concentration
The UV absorption spectra of CDOM changes across the types of CDOM. Some types of
CDOM are closer in their absorption to nitrate than others. Types of CDOM that absorb
similar to nitrate will cause a larger bias than those that absorb dissimilarly. Thus, the
concentration of CDOM alone cannot predict the magnitude of the bias.
Quantification and correction of CDOM impact
Under ideal conditions, CDOM would be isolated from all other absorbers, and its
absorbing properties identified in isolation. A more realistic approach is to independently
find the content (nitrate, salinity, CDOM) of a number of water samples (if CDOM is stable
over time), and calculate the CDOM-induced bias on the nitrate concentration.
FDOM: Fluorescent Dissolved Organic Matter is a subset of CDOM and can be used as a
proxy (if the composition is stable over time). Most FDOM sensors use a 370 nm
excitation source that targets more humic substances, and may not represent absorption
in the nitrate range (~220 nm).
Absorption: The data output of the SUNA V2 is the absorption at 350 nm and 254 nm
(A350 and A254). These wavelengths are outside the nitrate absorption range and can be
used to make an estimate of the impact of CDOM. If absorption is high (>1.3 AU), the
SUNA will not be able to collect adequate light to make a measurement.
RMSE: The root mean square error parameter from the SUNA V2 can be used to make
an estimate of how well the nitrate spectral fit is. This should usually be less than 1E-3. If
it is higher, there is spectral shape (likely due to CDOM) that adversely impacts the nitrate
estimate.
Pathlength: SUNA V2 comes in both a 10 mm and a 5 mm pathlength version. Because
absorbance is directly proportional to pathlength, a halved pathlength gives a tolerance of
approximately twice the background absorption.

8.7 Optional equipment
8.7.1 Wiper

The wiper cleans the optical window of biological growth and particulates so that the
quality of the data collected stays constant. The wiper works in all modes of operation of
the sensor. The wiper operates one time before each time that data is collected.
The wiper operates at 90 degrees. Make sure the wiper can operate without any
blockage. Each cycle of the wiper across the optical window takes approximately
15 seconds. There is a minimum required delay of 30 seconds between wiper cycles.

Figure 5  SUNA with wiper
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The wiper drive shaft has a mechanism that lets the wiper be moved manually without
damage. Make sure that the wiper is not bent or pushed off of its axis of rotation.

8.7.2 Anti-fouling guard
Use the anti-fouling guard for moored deployments that do not use a pump. The guard is
attached to the sensor by a plastic clamp. The foul guard is made of perforated copper
that goes around the sample volume to prevent biofouling and lets the sample volume
flush. Operate the sensor horizontally and point the sample volume area downward so
that air bubbles and sediment do not collect.

Figure 6  Copper anti-fouling guard

8.7.3 Flow cell
Use the flow cell for moored deployments that require a pump. Attach the flow cell to the
sensor with the manufacturer-supplied plastic clamp. The flow cell seals against the
pressure housing of the sensor so that the water from the pump flows across the optical
path of the sensor. The flow cell has a copper tube on the inlet port and a plastic barbed
fitting on the outlet port that connects to the pump with flexible tubing. Spare parts for the
flow cell include elbow fittings so that the user can adjust the position of the sensor for
deployment.

Figure 7  SUNA flow cell

Reference

45



Reference

46



Section 9 Software reference

9.1 Sensor dashboards
The Dashboard is the main area from which to control and communicate with the sensor.
Information about the status of the sensor is contained in the upper part of the window
and is updated each time the sensor is connected to the software.
Common settings

• Connect-Disconnect lets the user disconnect the sensor after it is set up for
operation.

• Start-Stop lets the user start and stop data collection.
• Sensor Settings lets the user select options for a specific deployment.
• Deployment Wizard lets the user select a deployment mode, start time, the

parameters to measure, estimate the deployment time and data collection interval,
and make a summary report of the status of the sensor.

• Transmit Data lets the user move data saved on the sensor to a PC.
• Show Saved Data lets the user see data that was saved on a PC in a graph.
• Command Terminal lets the user send terminal program-level commands to the

sensor.

9.2 UCI menu
The user can set up the way that the software saves information about the operation of
the sensor and change the way that the data looks from the Preferences menu.

9.2.1 General tab
Enter or change the directory on the PC in which data from the sensor is stored.

• "Maximum Wakeup Attempts" lets the user select the number of times the software
will try to connect to a sensor. Range: 5–15.

• "Response Timeout" is the interval of time between communication between the
sensor and the software. Range: 5–10.

• "Default Data Directory" lets the user enter the location on the PC in which to save
data from the sensor. If there is a check in the "Prompt at startup" box, the user can
change the directory in which the data is stored every time the software starts.

9.2.2 Display tab
Note: The software operates faster if the user selects less data and only one or two graphs.

Data that is collected by the sensor shows in the user-selected graphs in the
Performance Optimization Settings area of the Display tab.
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• RS232 only: "Enable Real Time Display"—Put a check in this box to see the data as
it is collected in either the software, or if deployed, a terminal program.

• "Enable Time Series Graph"—Put a check in this box to see user-selected data.
Remove the check in the box to so that the graph is disabled and the data does not
show.

• SUNA only: "Enable Spectra Graph"—Put a check in this box to see both dark and
light data in raw counts. Refer to Monitor data in spectra graph on page 11 for details.

• SUNA only: "Enable Total Absorbance Graph"—Put a check in this box to see the
calculated absorbance. Refer to Monitor data in absorbance graph on page 12 for
details.

Time Series Settings—The default is a check in the box for continuous data collection
that is not limited to a specified amount of time. Remove the check in the box to enable
the "Time Axis Range Limit" of 60 minutes (default value). Only the most recent hour of
data will show in the Time Series Graph. The user-selectable range is 1–1440 minutes.

9.2.3 Message tab
The software automatically saves files that have information about sensor use, data
collection, and software operation over time. This information helps the user and
Customer Support find problems and troubleshoot.
When the "Display Dialog for Error Level Messages" box has a check in it, the software
saves one of five levels of error messages.

• INFO—The default level. All high-level operations are saved.
• ERROR—Minimum level. Only errors that need to be examined by the user or

Customer Support are saved.
• WARN—Low level. The files that are saved do not have enough information for the

user to make an analysis of how the sensor is used and set up.
• DEBUG—High level. Used to troubleshoot. DEBUG and TRACE files are very large.
• TRACE—The highest level. Used only to troubleshoot.

"Daily Files"—all messages from a single day are saved in one file.
"Rolling Files"—all messages are saved in one file until it is the maximum size specified
by the user. The messages are then saved to a new file. The user specifies the number of
files to keep. The oldest files are erased first.
"Save Lost Bytes"—if this box has a check in it, the software saves all of the unexpected
output from the sensor to a file.
"File Location"—the operating system of the PC determines where these files are saved.
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9.3 Sensor menu
The Sensor menus have options for each sensor with which the software communicates.
Refer to the sections on Sensor dashboards on page 47 for more information about these
items.
Advanced Sensor menu items
Common

• Erase Data lets the user erase all of the data stored in the sensor.
• Summary Report lets the user get a summary of the settings stored in the sensor.
• Set Clock lets the user synchronize the time between the PC and the sensor.
• Collect Diagnostics is helpful for troubleshooting.

9.3.1 SUNA
• Edit Data File Headers lets the user put labels on data files.
• SUNA Self Test—the software does a test of the sensor function. The output shows

in the Instrument Console tab.
• DAC Calibration lets the user do a digital-to-analog calibration (does not apply to

coastal deployments).
• Upload Firmware File lets the user update the firmware in the sensor.
• Administrative Settings is used only by the manufacturer.
• Upload Instrument XML File is an .xml file necessary for the sensor to process data.

9.4 Data menu
The Data menu has sensor-specific options to look at data that has been saved to a PC.

9.4.1 Show data from multiple sensors
The software lets the user show data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to look at.

1. Go to the Data menu, then Show Data from Sensor.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors to Show.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.

9.4.2 Export data to .csv or MS Excel format
Data from the sensor can be saved to either a comma-separated (.csv) file or a
Microsoft® Excel file with a local or UTC time stamp. Use the software to transmit data
from the sensor and then export that data to a human-readable format.

1. From the Data menu, select Export Stored Data.
2. Push Browse to find the file to export.
3. Select the file from the list.
4. Push Open.
5. Push Next. The current output format shows (all sensors but SUNA).
6. Push Next. Select the options for the file to export:

a. Select either "Excel Workbook" or "Comma Separated Values" in Export File
Format.

b. Select either the "UTC" or "Local" time stamp in Format Options.
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7. Push Browse to select the directory in which the exported data will be saved.
8. Push Finish.

9.4.3 Show data from the sensor
1. Go to the Data menu and select the applicable sensor.
2. Push Show Data from Sensor.
3. Select the data file to look at.
4. Push Open. The data shows in the Time Series graph.

9.5 View menu
Dashboards—Go to the View menu and Dashboards to select the dashboard for a
specific sensor.
Graphs

• Time Series Graphs—all supported sensors.
• SUNA—Spectra, Absorbance, or Reprocessed Nitrate.
• SeaFET—Processed pH graph.

• SUNA Spectra graph: the user can push Configure to change the number of graphs
to view. The "Graph History Limit" range is 1–2147483647. Put a check in the "Graph
History Unbounded" box to see the total number of graphs. Default value: no check in
the box and a "Graph History Limit" of 1.

• SUNA Absorbance graph: the user can change the "Min. Wavelength Cutoff" to
between 150–400 nm to change the scale of the graph. The user can push
Configure to change the number of graphs to view. The "Graph History Limit" range
is 1–2147483647. Put a check in the "Graph History Unbounded" box to see the total
number of graphs. Default value: no check in the box and a "Graph History Limit" of
1.

• SUNA Reprocessed Nitrate graph: the user may find that it helps to reprocess data
under some conditions.

Output—Go to the View menu and select Output, then any of the three options:

• Instrument Console: the current settings in the sensor
• Processing Console: the data collected by the sensor in a comma-delimited format
• Application Console: the commands sent to the sensor from the software.

Real Time Data—Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Collection—Go to the View menu and select Data Collection to select the location
on the PC in which the collected data is saved.
Acquisition Monitor—Used by the manufacturer for troubleshooting.
Message File—Used by the manufacturer for troubleshooting.

9.6 Window and Help menus
The user can change how the software shows different windows and tabs.

• Close Current Window—closes the selected tab (highlighted in blue).
• Close all Windows—closes all tabs except the UCI Dashboard.
• Configure Window—

Maximize: increases the size of the selected tab to fill the software screen size.
Float: unlocks the selected tab from the software screen so that the user can move it
to other locations on the PC screen.
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Float Groups: the same as Float above, but all tabs that are open are unlocked so
that the user can move them to other locations on the PC screen.
Minimize: minimizes the selected tab and moves it to the side of the software screen.
Minimize Group: minimizes the open tabs in the "Console," "Dashboard," or "Graph"
areas of the software.
Dock: locks the tab that the user selected to "float" back to its previous position in the
software window.
Dock Group: the same as Dock above, but all tabs that are open are locked back into
their previous position in the software window.

Go to the Help menu to see the .pdf version of the user manuals for supported sensors
and this software reference. Go to Sea-Bird.com to go to the manufacturer's web site.

9.7 Other general settings

Sample Averaging, Deployment Characteristics—The average of the number of frames
selected. The higher the value, the more time it takes to make a measurement. The
"Estimated Frame Rate" is directly related to the "Number of Measurements per Frame."
The manufacturer recommends a value of 10–15 as the "Number of Measurements per
Frame" to increase precision in a stable water sample. Use a lower value for unstable
water samples.
Wiper Settings—If the sensor is equipped with a wiper, the user can put a check in this
box so that the wiper will operate before each measurement.
SUNA Messages—The sensor gives information about the sensor operation and
collected data. The default is "Info."

• "Error" gives the least information.
• "Debug" and "Trace" give the most information and are used only for troubleshooting.

Set the "Maximum File Size" to "0" to turn off the messages.
Options to monitor data
The user can select additional parameters to look at from the Real Time Display tab in the
main window of the software. Push Select Sensors and put a check in the box next to
the parameter to measure.
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Section 10 Troubleshooting

W A R N I N G
 

Nitrate sensors use an ultraviolet (UV) light. Do not look directly at a UV light when it is
on. It can cause damage to the eyes. Keep products that have UV light away from
children, pets, and other living organisms. Wear polycarbonate UV-resistant safety
glasses to protect the eyes when a UV light is on.

Table 5  General
Possible problem Possible solution

Sensor does not appear to be on Make sure that the cable is connected and the power source is on.

Turn the sensor off for at least 60 seconds. Turn the power on again. If the sensor still
does not appear to be on, use a different cable.

Make sure that the voltage supplied to the sensor is between 8–15 VDC with at least
1 amp of current. Check the cable voltage: put the leads of a DMM in DC voltage mode at
contacts 1 (+) and 2 (-) of the cable to see if there is voltage. If not, use a different cable.

Make sure of the mode of operation. The sensor may be in an unknown mode. Start a
terminal program, supply power to the sensor, and type "$" then "Enter" three or more
times. A prompt from the sensor shows.

Verify the continuity of the cable. Refer to the sensor specifications for connector
functions.

Verify the power consumption. Use a power supply with an accurate digital current
indicator.

• current > 500 mA at 12V: sensor is in data collection mode. Put a piece of white
paper into the optical area and make sure that there is a blue spot. If there is not, the
sensor may be in an unknown mode or there is a system failure.

• current > 5 mA: sensor is in "standby" mode and gives a result over the RS232 input.
• current >100 µA: sensor is not in operation. Contact Customer Support.

Table 6  Operations
Possible problem Possible solution

Self-test fails for internal
humidity

Monitor the sensor and do a sensor self-test at regular intervals. Make sure that the
sensor is not attached to any frame so tightly that the pressure housing is out-of-round.

Self-test fails for low spectrum
average or high dark counts

Clean the optical windows with a low-lint swab or tissue and isopropyl alcohol.
The average value in DI water is within specifications shown below.

• Dark spectrum: 500–1000 counts, with a standard deviation of no more than
12 counts.

• Maximum light spectrum: no more than 55000, with no more than 60-count standard
deviation.

• Average light spectrum: approximately 10000–15000 counts, with ranges to at least
20000 counts. An average value of <10000 may mean that the optical windows are
dirty or stained, or that the lamp is degraded.

Baseline "drift" Look to see if the lamp is degraded. Apply drift corrections if the rate is approximately
0.004 mgN/L per hour of lamp "on" time.

Wiper does not operate correctly • Make sure that there is a check in the box for "Integrated Wiper Enabled" in the
General tab of the Settings tab of the software.

• Verify the alignment of the wiper brushes and make sure that the wiper is not bent.
• If the wiper is from another manufacturer, check that the battery contacts are

functional.
• Contact Customer Support for further help.
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Table 7  Communication
Possible problem Possible solution

Collected data is different from
transmitted data

• Verify the clock settings in the sensor.
• Make sure that there is no extra averaging or data collection in the setup.
• Verify the data output settings.

Problems with sensor-to-
software communication

• Make sure that the sensor–PC cable is connected correctly.
• Make sure that the current software and firmware are installed.

Self-test fails to complete Make sure that the sensor has an external power source; external power is necessary to
turn on the lamp.

Data warnings and error
messages

Contact Customer Support. If possible, have the information listed below:

• screenshot of the "Application Console" of the software.
• "messages.log" file—go to the Transmit Files window and select the Saved Files tab.

Copy the file to the PC for Customer Support.

Negative nitrate concentration Clean the optical area and check the reference spectrum. Apply a new one if necessary.

• Make sure that the sensor is in water.
• Make sure that the "Deploy in Fresh Water" box has the appropriate check in it.
• Verify the salinity compensation.

Analysis of nitrate standard
shows sensor is possibly out of
specification

Make sure that the nitrate standard concentrations are accurate. Make sure the dilutions
were done correctly and that the standards are used within 1 week (in the lab) or before
expiration (unopened standards). Verify that the standards were made in comparable units
(mg/L as nitrogen or µMoles).

Verify the sensor settings. Make sure that the "Deployed in Fresh Water" setting has a
check in the box if the sensor operates in fresh water.

Poor correlation with field
samples (grab samples)

Look at the sensor for fouling or lamp change ("drift"). Clean the optical windows and do a
blank test.

• Set the sensor to do a self-test. Check light:dark counts, such as high CDOM or other
absorbers and other data about the sensor.

• Look for matrix interferences that can cause measurement errors. Do measurements
for a wider range of constituents an do possible lab matrix spikes to isolate the cause.

Verify the representativeness of the data collection site. If the data from the sensor does
not agree with grab samples but shows good performance, the site may not be
representative of conditions, or the water is not well mixed.

Data collection rate is very slow Verify that the internal memory is on. Data collection starts after approximately 5 seconds.

Verify that the "adaptive integration" is on. Data collection starts after approximately
500 milliseconds (20 × "integration period").

Nitrate values are not stable • Make sure that the optical area is not blocked with debris.
• Make sure that the wiper functions correctly.
• Clean and dry the optical area.

Nitrate value are frequently "-1"
or "NAN"

Make sure that the lamp intensity is sufficient. Measure the spectrum in DI or tap water.
Maximum output is > 10000. For best case, > 30000.

Look at the data: if the maximum is < 1000 and the lamp intensity is sufficient, the water
sample is optically dense.

SELFTEST alert for lamp
intensity or high humidity

Does the sensor have high internal humidity? Do a "selftest":
if humidity is > 50%, the sensor may have a leak. Contact Customer Support.
if humdity is > 30%, the sensor is probably ok. Contact Customer Support.

Troubleshooting
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Section 11 General information

Revised editions of this user manual are on the manufacturer's website.

11.1 Warranty
Refer to the manufacturer's website for warranty information (seabird.com/warranty).

11.2 Service and support
The manufacturer recommends that sensors be sent back to the manufacturer annually to
be cleaned, calibrated, and for standard maintenance.
Refer to the website for FAQs and technical notes, or contact the manufacturer for
support at support@seabird.com. Do the steps below to send a sensor back to the
manufacturer.

1. Complete the online Return Merchandise Authorization (RMA) form or contact the
manufacturer.
Note: The manufacturer is not responsible for damage to the sensor during return shipment.

2. Remove all batteries from the sensor, if so equipped.
3. Remove all anti-fouling treatments and devices.

Note: The manufacturer will not accept sensors that have been treated with anti-fouling
compounds for service or repair. This includes AF 24173 devices, tri-butyltin, marine anti-
fouling paint, ablative coatings, etc.

4. Use the sensor's original ruggedized shipping case to send the sensor back to the
manufacturer.

5. Write the RMA number on the outside of the shipping case and on the packing list.
6. Use 3rd-day air to ship the sensor back to the manufacturer. Do not use ground

shipping.
7. The manufacturer will supply all replacement parts and labor and pay to send the

sensor back to the user via 3rd-day air shipping.

11.3 China RoHS disclosure table
Name of Part Hazardous substance or element in product

Pb Hg Cd Cr(VI) PBB PBDE

PCBs X O O O O O

This table is compiled to the SJ/T 11364 standard.

O: This hazardous substance is below the specified limits as described in GB/T 26572.
X: This hazardous substance is above the specified limits as described in GB/T 26572.
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